
What is a PDF? 
• PDF stands for Portable Document Format
• Non-proprietary Format (can be freely read and distributed)
• Keeps True to Format/Layout of a Print Document
• Cross Platform Compatibility
• PDF is an export format type of document – just as you would get a piece of paper from

a printer, you get a PDF from Acrobat
Structure of a PDF File 

• Visual Layer (Physical Layer)
o This is what you would associate as a PDF File – it is the version that would exist

if you were to print out the PDF in hard copy
• Text Layer (Content Layer)

o This layer contains the textual information that is associated with the Visual
Layer. In an accessible PDF, the reading order of the Content Layer mimics the
order implied by the Visual Layout of the document.

• Tags Layer
o The Tags Layer contains the PDF tagging structure (similar to HTML markup for a

webpage) that is used by assistive technology
o Notes indicating what you visually see, Text of visual layer, structural Tags

What Makes a PDF Accessible? 
Accessible PDFs include but are not limited to the following characteristics: 

• Start with a well Structured Source Document (ex. WORD)
• PDF is Tagged

o Provides the structured, textual representation of the PDF that is presented to
assistive technology such as screen readers

• Has a Logical Reading (Tag) Order
o The order in which Tags are displayed is the order in which they will read out

loud to a user of assistive technology
• PDF is Not a Scanned document
• Has a Descriptive Filename that identifies the document or purpose
• Text available Selectable (content copying for accessibility allowed)
• Document Language Specified and matches the main language of the document
• Decorative Content

o Text and objects are set to Artifact
• Headings

o Correspond to heading tags
o Heading levels match the visual outline level

• Lists
o Correspond to list tags
o Correspond to list item tags
o <LI> are nested under <L>

For more information on Section 508 compliance, please visit the FEMA Section 508 Accessibility Resource Center. 
For assistance with Section 508 matters, please email the FEMA-Accessibility Help Desk. 

https://intranet.fema.net/help/section508/Pages/Section-504-Self-assessment-Support.aspx?PagePreview=true
mailto:fema-accessibility@fema.dhs.gov


   

 
 

• Descriptive Text defined for all Images 
o Conveys the purpose and/or function of the image or object 
o Descriptive text matches verbatim text within image 

• Data Tables  
o Table headers are marked at <TH> 
o Identified with <TABLE> tag and not <FIGURE> tag 
o Complex table cell properties are set for header and data cells 

• Hyperlinks that are descriptive of destination, function or purpose 
• Form Fields  

o Tooltips match the label of instructions 
o Tab order matches the visual/logical order  

• Color and Other Sensory Characteristics 
o Text conveys the meaning of color or sensory characteristics 

• Color Contrast 
o Color contrast ratio is lower than 4.5:1 

Why Make Accessible PDFs? 
• Accessibility of tagged PDF files available since 2001 
• Most current assistive technologies work with tagged PDFs 
• PDF file format is ubiquitous 
• No need for duplication of effort 
• Security of Accessible PDF files available 
• Universal Design 
• PDF may be the best format 

Problems with PDF Documents 
• PDF files were designed to be printed – Static 
• Accessibility not as defined as HTML (HTML allows for flexibility/customization) 
• Need special tools to correct accessibility of PDF documents (Adobe Acrobat Pro) 
• Retrofitting can be difficult 

Process of Creating Accessible PDFs 
• Prepare your documents to create an accessible PDF 
• Check your PDF for accessibility 
• Correct accessibility problems with Adobe Acrobat Professional 
• Review page for accessibility 

 



Setting up Adobe Acrobat Professional XI 
You’ll need to locate a few panels and tool bars in order to make PDF files accessible. 

Navigation Panes Panel 
Right click on the Navigation Panes panel (the dark gray area to the left of your work space) and a 
Menu will open as seen in the figure below: 

Figure 1 - Navigation Panes Menu 

Choose the following, one at a time (it doesn’t matter what order) – they will be put in a specified 
order on the Navigation Panes panel: 

• Content
• Order
• Tags

Your Navigation Pane panel should now look like the figure below. 

Figure 2 - Navigation Panes with the new panes added 



 

Tools Panel 
The Accessibility Tools can be found in the Tools panel on the right of Acrobat’s main content window.  

To view the Accessibility Tool Panel, select the Options Menu (see below) in the upper right hand 
corner and choose Accessibility as shown in the image below. You can also choose other tool panels 
you think you may need. 

 
Figure 3 - Tools Panel options menu with 
Accessibility option selected 

 
Figure 4 - Accessibility Tools Panel will open 
with access to a number of accessibility options 
once the Tools option has been selected. 

While not vital, you can also add these tools to your toolbar for quick access.  If this is your first time 
opening Acrobat, or if you’ve not added Accessibility Tools to your Toolbar, your Toolbar should look 
like the figure below. 

 
Figure 5 - Adobe Acrobat XI toolbar with the default tools shown 

https://intranet.fema.net/help/section508/Pages/Section-504-Self-assessment-Support.aspx?PagePreview=true
mailto:fema-accessibility@fema.dhs.gov


 
 

 
 

Now you’ll want to right-click on the Toolbar 
and Edit Current Tool Set as shown in the 
images below:

 
Figure 6 - Toolbar menu with Edit Current Tool 
Set selected 

 

A dialog box will appear as shown in the images 
below. Expand the Accessibility Tools by clicking 
on the triangle in front of Accessibility. 

 
Figure 7 - Edit Tool Set dialog box with the 
Accessibility Tools expanded 

 

Select the following tools under Accessibility in 
the Choose Tools to Add pane (there does not 
seem to be an option to add more than one at 
a time) and press the <+ >sign in the green 
circle next to the upward pointing arrow. Then 
choose Save: 

• Accessibility Full Check 
• Open Accessibility Report 
• Add Tags to Document 
• Set Alternate Text 
• Run Form Field Recognition 
• Add Form Fields to Tags 
• Touch Up Reading Order 



 
 

 
 

Creating Accessible Scanned PDFs 
Most scanned PDFs are merely images, like a photo of the page. In order to ensure your 
scanned document is accessible to users of assistive technology, you'll need to perform OCR 
(Optical Character Recognition) on the document to convert the images of words into actual 
text on a page.   

  

Many times documents are created by scanning – instead of 
saving in the OCR or text setting – it is just a picture of shapes 
that resemble a text font. 

• Place your cursor in the text area of the document 
• Note if your cursor changes 
• Try to highlight the text 

 
1. Once you’ve opened the document in Acrobat, click on 

Tools, a menu bar located at the top right of the screen, 
to bring up the toolbar on the right side of the screen.  

2. Click on <Text Recognition> to expand the menu. 
3. Select <In this File> to bring up the OCR menu box. 

 

1. When the Recognize Text box comes up, choose how 
many pages to OCR at once. If it is a large file, try only a 
few at first, since it could take a while. Otherwise select 
the All Pages radio button and click OK.  
 

2. Once the process finishes running, you should repair 
any problems found during OCR conversion, and correct 
structural issues such as lists, tables, links, headings, etc.  
 

3. Ensure to add descriptive tags for non-text elements: 
graphs, charts, images, add accessible mark-up for 
tables, and verify the read-order of the document. 

 
4. If the OCR process cannot be performed for some 

reason, then the other option is to provide alternative 
text for the document image (as text content within the 
document) or add text within the alternative text dialog 
box describing the image. 
 

 

 

http://accessibility.colostate.edu/pdfScanned.cfm


Accessibility Checker Full Check 
The "Full Check," attempts to validate the existing tags and insure that all content is associated 
with a tag and that tags include all required information. 

Accessibility Checker Options  
The Accessibility Checker (Full Check) has the following options that can be selected: 

Document 
• Accessibility permission flag is set
• Document is not image-only PDF
• Document is tagged PDF
• Document structure provides a logical reading order
• Text language is specified
• Document title is showing in title bar
• Bookmarks are present in large documents
• Document has appropriate color contrast

Page Content 
• All page content is tagged
• All annotations are tagged
• Tab order is consistent with structure order
• Reliable character encoding is provided
• All multimedia objects are tagged
• Page will not cause screen to flicker
• No inaccessible scripts
• Navigation links are not repetitive
• Page does not require timed responses

Forms, Tables and Lists 
• All form fields are tagged
• All form fields have description
• TR must be a child of Table, THead, TBody, or TFoot
• TH and TD must be children of TR
• Tables must have headers
• Tables must contain the same number of columns in each row and rows in each

column
• Tables must have a summary
• LI must be a child of L
• Lbl and LBody must be children of LI

Alternate Text and Headings 
• Figures require alternate text
• Alternate text that will never be read
• Alternate text must be associated with some content



 
 

 
 

• Alternate text should not hide annotation  
• Elements require alternate text  
• Appropriate heading nesting  

 
Accessibility Checker Panel  
Once a report has been run, the issues that have been found are displayed in the Accessibility 
Checker panel. The results tree displays one of the following states for each rule check:  

Passed: The item passed this accessible check.  
Passed Manually: The item was marked passed by manual inspect.  
Skipped By User: The rule was not selected in the Accessibility Checker Options dialog box.  
Needs Manual Check: The Full Check feature could not check the item automatically. Verify 
the item manually.  
Failed: The item did not pass the accessibility check. 

Accessibility Checker Option Details 
Option Explanation How to Fix 

Accessibility 
permission 
flag 
 

A document author can specify that no part of an 
accessible PDF is to be copied, printed, extracted, 
commented on, or edited. This setting can 
interfere with the user of a screen reader’s ability 
to read the documents screen readers must be 
able to copy or extract the document’s text to 
convert it to speech.  
This flag reports whether it’s necessary to turn on 
the security settings that allow accessibility.  

To fix the rule 
automatically, select 
Accessibility Permission 
Flag on the Accessibility 
Checker panel. Then, 
choose Fix from the Options 
menu. 

Image-only 
PDF 

Reports whether the document contains non-text 
content that is not accessible. If the document 
appears to contain text, but doesn’t contain fonts, 
it could be an image-only PDF file. 

To fix this item 
automatically, select Image-
only PDF on the 
Accessibility Checker panel, 
and choose Fix from the 
Options menu. This will 
open the “Recognize Text - 
General Settings” dialog 
and then perform optical 
character recognition (OCR) 
on the document. 

Tagged PDF If this rule check fails, the document is not tagged 
to specify the correct reading order for reflow and 
assistive technology. Documents without tags also 
do not provide information describing the logical 
structure and relationship of elements to users of 
assistive technology. 

To fix this item 
automatically, select 
Tagged PDF on the 
Accessibility Checker panel, 
and then choose Fix from 
the Options menu. Acrobat 
automatically adds tags to 



 
 

 
 

Option Explanation How to Fix 
the PDF. The tags that were 
added still must be 
reviewed to ensure they are 
correct. 

Logical reading 
order 

Make sure that the reading order displayed in the 
Tags panel reflects the logical reading order of the 
document. 

Verify this rule check 
manually. 

Primary 
language 

Setting the document language in a PDF enables 
some screen readers to switch to the appropriate 
language. This check determines whether the 
primary text language for the PDF is specified. If 
the check fails, set the language. 

To set the language 
automatically, select 
Primary Language in the 
Accessibility Checker tab, 
and then choose Fix from 
the Options menu. Choose 
a language in the Set 
Reading Language dialog 
box, and then click OK. This 
does not set the language 
for specific parts of the 
document that may be in 
different languages. To set 
specific portions of the 
document in different 
languages refer to the 
Adobe Acrobat XI Pro 
Accessibility Repair 
Workflow guide. 

Title Reports whether there is a document title. 
Document authors can choose to have the title 
appear in the Acrobat or Adobe Reader application 
title bar rather than the document file name. 

To fix the title 
automatically, select Title in 
the Accessibility Checker 
tab, and choose Properties 
from the Options menu. 
Enter the document title in 
the Description dialog box. 

Bookmarks This check fails when the document has 21 or 
more pages, but does not have bookmarks that 
parallel the document structure. 

To add bookmarks to the 
document, select 
Bookmarks on the 
Accessibility Checker panel, 
and choose Fix from the 
Options menu. In the 
Structure Elements dialog 
box, select the element(s) 



 
 

 
 

Option Explanation How to Fix 
that you want to use as 
bookmarks, and click OK. 

Color contrast When this check fails, it’s possible that the 
document contains content that is not accessible 
to people who have low vision or color 
deficiencies. 

There must be contrasting 
colors/shades at a ratio of 
4.5:1 for discerning 
between background and 
foreground content. 
Utilize the contrast 
checking tool to determine 
if contrast is sufficient. 

Tagged 
content 

This check reports whether all content in the 
document is tagged. Make sure that all content in 
the document is either included in the Tags tree, or 
if decorative marked as an artifact. 

Perform one of the 
following to fix this check:  
If the content is purely 
decorative, set it as an 
artifact.  
Use the Touch Up Reading 
Order tool to tag the 
content.  
Use the Tag panel to tag the 
content.  

Tagged 
annotations 

This option checks whether all annotations are 
tagged. Make sure that annotations such as 
comments and editorial marks (such as insert and 
highlight) are either included in the Tags tree if 
meaningful, or marked as artifacts if they’re purely 
decorative or duplicated in the content. 

If the content is purely 
decorative, set it as an 
artifact.  
Use the Tag Panel and the 
Find command to search for 
and tag the content as an 
annotation.  
To have Acrobat assign tags 
automatically to 
annotations as they’re 
created, choose Tag 
Annotations from the 
Options menu on the Tags 
panel. This is the easiest 
approach to tag 
annotations that have not 
already been created, as 
the annotation tags will 
appear in the correct 
location in the reading 
order of a properly tagged 
document. 

http://www.paciellogroup.com/resources/contrastAnalyser
http://www.paciellogroup.com/resources/contrastAnalyser


 
 

 
 

Option Explanation How to Fix 
Tab order Because the Tab key is often used to navigate links, 

annotations, and form fields in a PDF, it’s 
necessary that the tab order parallels the 
document structure.  
 

To fix the tab order 
automatically, select Tab 
Order on the Accessibility 
Checker panel, and choose 
Fix from the Options menu. 
This will specify the tab 
order to follow the 
document structure. 

Character 
encoding 

Specifying the encoding helps PDF viewers present 
users with readable text. However, some 
character-encoding issues are not repairable 
within Acrobat. 

To ensure proper encoding, 
do the following:  
Verify that the necessary 
fonts are installed on your 
system.  
Use a different font 
(preferably OpenType) in 
the original document, and 
then re-create the PDF.  
Re-create the PDF file with 
a newer version of Acrobat 
Distiller.  
Use the latest Adobe 
PostScript driver to create 
the PostScript file, and then 
re-create the PDF.  

Tagged 
multimedia 

This rule checks whether all multimedia objects are 
tagged. Make sure that content is either included 
in the Tags tree or, if decorative or duplicative, 
marked as an artifact. 

Perform one of the 
following to fix this check:  
If the content is purely 
decorative, set it as an 
artifact.  
Use the Touch Up Reading 
Order tool to tag the 
content.  
Use the Tag panel to tag the 
content.  
In addition to providing tags 
and description of all 
multimedia, captions (for 
people who are deaf or 
hard of hearing) or audio 
descriptions (for people 
who are blind or visually 
impaired) may need to be 
synchronized with the 



 
 

 
 

Option Explanation How to Fix 
multimedia. Please refer to 
the relevant guideline or 
standard for multimedia 
requirements. 

Screen flicker Elements that make the screen flicker, such as 
animations and scripts can cause seizures in 
individuals who have photosensitive epilepsy. 
These elements can also cause difficulty for users 
with low vision and people with cognitive 
disabilities.  

If the Screen Flicker rule 
fails, manually remove or 
modify the script or content 
that causes screen flicker. 

Scripts Content cannot be script-dependent unless both 
content and functionality are accessible with the 
keyboard and to assistive technologies. Make sure 
that scripting does not interfere with keyboard 
navigation or prevent the use of any input device.  

Check the scripts manually. 
Remove or modify any 
script or content that 
compromises accessibility. 

Timed 
responses 

This check applies to documents that contain 
forms with JavaScript. If the rule check fails, make 
sure that the page does not require timed 
responses.  

Edit or remove scripts that 
impose timely user 
responses so that users 
have enough time to read 
and use the content. 

Navigation 
links 

For URLs to be accessible to screen readers, they 
must be active links that are correctly tagged in the 
PDF document and keyboard accessible. (The best 
way to create accessible links is with the Add or 
Edit Link command, which adds link objects that 
screen readers require to recognize a link.) Use the 
Tags panel’s Find command to properly tag Links 
that are not accessible. 
Link text must also be understandable on its own 
without surrounding content. If this rule check 
fails, check navigation links manually and verify 
that the content does not have links with an 
identical name but different target locations.  
Either change the link text or add actual text to the 
link tag to provide additional description out of 
context for users of screen readers.  
Documents must also provide a way for users to 
skip over items that appear multiple times. For 
example, if the same links appear on each page of 
the document, also include a bookmark element to 
skip past the repetitive link group to the next 
tagged element in the structure. Links cannot be 

To ensure an actionable link 
is given the proper role: 
• Locate the tag 

containing the visual 
link text in the Tags 
pane. 

• Highlight the parent tag 
of the link text. 

• Press F2 on the 
keyboard and type 
<Link>; OR, 

• Activate the Context 
menu of the parent tag, 
select Properties and 
select Link from the 
Type combo box in the 
TouchUp Properties 
dialog. 

• Confirm there is a 
<Link> tag as a parent 
tag to the link text and 
Link-OBJR tags. 



 
 

 
 

Option Explanation How to Fix 
used to skip past repetitive links as links cannot 
focus tags in the tree and only scroll or zoom to a 
particular page view. 

Tagged form 
fields 

All form fields must be tagged with a form tag and 
form object element and part of the document 
structure. In addition, field descriptions (labels) 
must be provided via the tooltip form field 
property to provide the user with a label or 
instructions for a field. 
 

To tag form fields, choose 
Tools > Accessibility > Add 
Tags To Form Fields. This 
add the tags and form 
object elements to the form 
fields in the proper location 
in the Tags panel. This step 
does not add field 
descriptions. 

Field 
descriptions 

All form fields must have a text label/description 
(this is set via the form field’s tooltip property) 

To add a text description to 
a form field, use the form 
tools.  
The tooltip property is only 
visible via the mouse and 
not the keyboard, thus, on-
screen labels should also be 
provided for all user input. 

Figures 
alternate text: 

Make sure that images in the document either 
have alternate text or, if decorative, are marked as 
artifacts. 

If this check fails, perform 
one of the following:  
Select Figures Alternate 
Text in the Accessibility 
Checker panel, and choose 
Fix from the Options menu 
(or context menu). Add 
alternate text as prompted 
in the Set Alternate Text 
dialog box  
Use the Tags panel to add 
alternate text for images in 
the PDF.  
Use the Tags panel, Content 
Panel, or Touch Up Reading 
Order tool to make the 
content an artifact.  

Nested 
alternate 
text/actual 
text: 

Screen readers do not read the alternate/actual 
text for nested elements. Therefore, do not apply 
alternate text to elements with children unless the 
alternative text or actual text covers the content 
for these elements as well. Alternative text is used 

Remove alternate/actual 
text from nested elements 
via the Tags panel. 



 
 

 
 

Option Explanation How to Fix 
to provide an alternative for images (figures). 
Actual text is used to provide an alternative to text 
content.  

Associated 
with content 

Make sure that alternate text is always an 
alternate representation for content on the page. 
If an element has alternate text, but does not 
contain any page content, there is no way to 
determine which page it is on. If the Screen Reader 
Option in the Reading preferences is not set to 
read the entire document, then screen readers 
never read the alternate text. 

To fix this issue, assign page 
content to the tag that 
contains the 
alternative/actual text. 

Hides 
annotation 

Alternate text cannot hide an annotation. If an 
annotation is nested under a parent element with 
alternate/actual text, then a screen reader will not 
announce it. 

Remove alternate/actual 
text from parent element. If 
alternate/actual text is 
needed make sibling 
objects out of content and 
the annotation and assign 
the actual/alternate text to 
the sibling tag. 

Other 
elements 
alternate text 

This option checks for content other than figures 
that requires alternate text such as multimedia, 
annotation, or 3D models. 

Make sure that alternate 
text is always an alternate 
representation for content 
on the page. If an element 
has alternate text but does 
not contain any page 
content, there is no way to 
determine which page it is 
on. If the Screen Reader 
Options in the Reading 
preferences is not set to 
read the entire document, 
then screen readers won’t 
read the alternate text. If 
additional description is 
required for the object 
beyond what can be 
provided in alternative text, 
provide a on-page 
description or link to a 
description of the non-text 
object. 



 
 

 
 

Option Explanation How to Fix 
Table Rows This check indicates whether each TR in a table is a 

child of Table, THead, TBody, or TFoot. 
To fix this issue ensure that 
any TR tags are a child of a 
Table, THead, TBody, or 
TFoot tag. 

Table TH and 
TD 

This check indicates whether a proper table 
structure exists. TH and TD must be children of a 
TR element; if not this check fails. 

To fix this issue, ensure that 
TH or TD tags are place 
under a TR tag. 

Table Headers For accessibility, it’s necessary that all tables in the 
PDF have a header. 

To fix this issue, ensure that 
all tables contain table 
header cells. 

Table 
Regularity 

To be accessible, tables must contain the same 
number of columns in each row, and rows in each 
column.  

To fix this issue, ensure that 
each table row has the 
same number of columns or 
the ColSpan and RowSpan 
properties of a cell are set 
properly to account for all 
cells in a row. 

Table 
Summary 

Table summaries are optional unless the table data 
cannot be understood without it. Summaries can 
improve accessibility in complex data tables or 
when the way in which the data is read may be 
important.  
It is a brief synopsis that contains a summary of 
the way the table is laid out - not a summary of the 
results. It should provide an orientation for 
someone who listens to the table.   

To fix this issue, provide a 
table summary for data 
tables where it is needed to 
make the data easier to 
understand, or to provide 
instructions on the data 
should be reviewed. 
 

List items This check reports whether each LI is a child of L 
tag. When this check fails, the structure of this list 
is incorrect. Lists must have the following 
structure: a List element must contain List Item 
elements; List Item elements can only contain 
Label elements and List Item Body elements.  

To fix this issue, ensure that 
all list item elements have a 
parent L tag. 

Lbl and LBody Lists must have the following structure: a List 
element must contain List Item elements; List Item 
elements can only contain Label elements and List 
Item Body elements. When this check fails, the 
structure of this list is incorrect.  

To fix the list structure, use 
the Tags panel to place Lbl 
and LBody elements under 
each list item. The list bullet 
or number should be a text 
node of the Lbl tag and the 
list item text a text node of 
the LBody tag. 

Heading This rule checks nested headings. When this check 
fails, headings are not nested properly. For 

To fix this issue, ensure that 
all heading levels are 



 
 

 
 

Option Explanation How to Fix 
Appropriate 
nesting 

example, a level 1 heading should precede a level 2 
heading, etc. The Accessibility Checker is not able 
to determine when heading structures must be 
used—that must be determined by manually 
reviewing the document.  

nested accordingly with no 
missing heading levels. Use 
the Tags Panel or Touch Up 
Reading Order tool to 
assign heading tags. 

Continue Checking Until All Issues are Addressed 

Repeat the process of running the Accessibility Checker and associated repair techniques along 
with the Hints for Repair until the Accessibility Checker indicates “Passed” for all selected tests. 

                                  
A Failed Accessibility Check    A Successful Accessibility Check 
 
 



 
 

 
 

Context Menu Option Description 

Many of the items in the summary are links 
that will take you to the problem area in the 
document you’ve checked.  

If you right click on one of the accessibility 
checker summary links a handy option menu 
opens and you are given several options 
(which can be different depending on which 
accessibility issue you’ve selected: 
 

 

 
 

 

Automatically fix the issue If you choose “Fix” the issue will 
either be automatically fixed or a 
dialog box will open for you to do an 
action. For instance a dialog box will 
open if you choose fix for missing alt 
text where you will then add the alt 
text for the highlighted image. 

 
Skip Rule If you’ve determined the rule does 

not apply to your document you can 
choose skip rule, however, use this 
wisely. Just because you get a “clean” 
report, your file may not be 
accessible. This may be used for 
skipping the “character encoding” 
rule when the characters with issues 
are bullets or unimportant images 
you’ve marked as artifacts. 

 



 
 

 
 

Context Menu Option Description 
Explain will open a web page that 
takes you to a detailed explanation of 
the issue. 

 

 

Show in Content panel Opens the content panel and 
highlights the content with an issue 

 
Show in Tags panel Opens the tags panel and highlights 

tag that has an issue 

 
Check Again If you’ve fixed the issue on your own, 

you can choose “check again” and the 
check will be run again 

Show Report Shows the accessibility report 

 
Options Opens the options window again 

 



What are PDF Tags? 

• Tags are one of the most important aspects of accessible PDF files.

• Tags provide the structure, textual representation of the PDF that is presented to
assistive technology (AT).

• Tags make AT devices such as screen readers able to navigate a PDF document.

• A screen reader reads the tag structure and therefore the tags must be in order and the
content must be properly tagged for a PDF file to be truly accessible.

• Tags are similar to HTML tags (for Web Sites) that define the document structure.

• PDF tag and HTML tag codes are similar, though not exactly the same and include such
familiar elements as paragraphs, headers, forms, captions, lists, tables and table cells,
and images/graphics.

• Acrobat tags also include many non-HTML elements such as formulas, annotations,
notes, parts, references, and sections.

• AT can determine paragraphs, lists, tables, form elements, etc. from tags.
• Tags are a duplicate copy of your document content with descriptive code (tags)

identifying each element of content
• A PDF without tags appear either blank or as one large block of text to AT.
• An untagged PDF can be read by assistive technology, however the user agent is really

just guessing at what the author intended and the screen reader will be reading the
guesses.



 
 

 
 

Predefined PDF Tags 
The following tags are predefined in tagged PDF.  

Tag Type Tag 
Article <Art> 
Annotation <Annot> 
Bibliography Entry <BibEntry> 
Block Quote <BlockQuote> 
Caption <Caption> 
Code <Code> 
Division <Div> 
Document  <Document> 
Figure <Figure> 
Form <Form> 
Formula <Formula> 
Heading <H> 
Heading Level 1 <H1> 
Heading Level 2 <H2> 
Heading Level 3 <H3> 
Heading Level 4 <H4> 
Heading Level 5 <H5> 
Heading Level 6 <H6> 
Index <Index> 
Label <Lbl> 
Link <Link> 
List <L> 
List Item <LI> 
List Item Body <Lbody> 
Note <Note> 
Paragraph <P> 
Part <Part> 
Quote <Quote> 
Reference <Reference> 
Section <Sect> 
Span <Span> 
Table <Table> 
Table Data Cell <TD> 
Table Header Cell  <TH> 
Table of Contents <TOC> 
Table of Contents Item  <TOCI> 
Table Row <TR> 

 



 
 

 
 

PDF Tags Explanation 
The following standard Adobe element tag types appear in the New Tag submenu in the Tags 
tab Options menu, as well as in the Tag Type pop-up menu in the TouchUp Properties dialog 
box.  
 
Block-level Elements 
All page elements that consist of text laid out in paragraph-like forms are referred to as block-
level elements. All block-level elements are part of the document’s logical structure and are 
represented in the tag tree. Such elements can be further classified as container elements, 
special text elements, heading and paragraph elements, and label and list elements.  
 
Container Elements 
These are the highest level of elements and provide grouping of other block-level elements:  

Tag Description 
Division element <Div> A generic block-level element or group of block-level elements 
Section element <Sect> 
 

A general container element type, comparable to Division (DIV 
Class="Sect") in HTML, which is usually a component of a part 
element or an article element 

Article element <Art> A self-contained body of text considered to be a single narrative 
Part element <Part> A part element defines a large division of a document, and may 

group smaller divisions together, such as article elements, 
division elements, or section elements 

Document element <Document> The root element of a document’s tag tree 
 
Special Text Elements 
These elements identify text that is not used in a narrative paragraph:  

Tag Description 
Block quote element <BlockQuote> One or more paragraphs of text attributed to someone 

other than the author of the immediate surrounding text. 
Caption element <Caption> A brief portion of text that describes a table or a figure. A 

caption element is different from a label element, which 
identifies but does not describe a table or a figure. 

Index element <Index> A sequence of entries that contain identifying text and 
reference elements that point out the occurrence of the text 
in the main body of the document. 

Table of contents element <TOC> 
 

An element that contains a structured list of items and 
labels identifying those items. A table of contents element 
has its own discrete hierarchy. 

Table of contents item element <TOCI> 
 

An item contained in a list associated with a table of 
contents element. 

 



 
 

 
 

 
Heading and Paragraph Elements  
These are paragraph-like block-level elements that include specific level headings and generic 
paragraphs <P>. A heading element <H> should appear as the first child of any higher level 
division. Six levels of headings <H1>–<H6> are available for applications that don’t hierarchically 
nest sections.  
 
Label and List Elements 
These block-level elements are used for structuring lists:  

Tag Description 
List element <L> A list can be any sequence of items of similar meaning or other relevance. 
List item element <LI> Any one member of a List. The immediate child elements of a list element 

should be list item elements. A list item element may have a label element 
(optional) and a label body element (required) as a child. 

Label element <Lbl> A label can be a bullet, name, or number that identifies and distinguishes 
an element from others in the same list. 

List body element <LBody> The descriptive content of a list item 
 
Table Elements 
These are special structural elements for structuring tables:  

Tag Description 
Table element <Table> A table is a two-dimensional arrangement of data or text cells that 

contains table row elements as children and may have a caption 
element as its first or last child element. 

Table row element <TR> One row of headings or data in a table. A table row element may 
contain table header cell elements and table data cell elements. 

Table data cell element <TD> A table cell that contains non-header data. 
Table header cell element <TH> A table cell that contains header text or data describing one or 

more rows or columns of a table. 
 
Inline-level Elements 
Inline-level elements are used to identify a span of text having specific styling or behavior. They 
are differentiated from block-level elements, and may be contained in or contain block-level 
elements. The standard inline-level elements are:  

Tag Description 
Bibliography entry element 
<BibEntry> 
 

A description of where some cited information may be found, 
which may contain a label element as a child element. 

Quote entry element <Quote> 
 

An inline portion of text attributed to someone other than the 
author of the text surrounding it. It is different from a block quote, 
which is a whole paragraph or multiple paragraphs, as opposed to 
inline text. 



 
 

 
 

Tag Description 
Span entry element <Span> Any inline segment of text. A common use of a span entry element 

is to delimit text associated with a given set of styling properties. 

 
Special Inline-level Elements 
Similar to inline-level elements, these elements are used to describe an inline portion of text 
that has special styling or behavior:  

Tag Description 
Code entry element <Code> Computer program text embedded within a document 
Figure entry element <Figure> A graphic or graphic representation associated with text 
Form entry element <Form> A PDF form annotation that can be or has been filled out 
Formula entry element <Formula> A mathematical formula 
Link entry element <Link> A hypertext link embedded within a document associated with a 

PDF link annotation that goes to another place in the same 
document or another document 

Note entry element <Note> Explanatory text, such as a footnote or endnote, that is referred 
to in the main body of text 

Reference entry element 
<Reference> 

A citation to text or data found elsewhere in the document 

 

 

 



 
 

Determining if the Document has been Tagged 
The most important step to begin creating an accessible document is to ensure that the document 
contains a tag structure.  

There are several ways to determine if a PDF document has been tagged: 

             Description Tab showing PDF is tagged 

 

 

View Document Properties  
1. Open the Document Properties 

dialog: File > Properties. 
2. Look for the “Tagged PDF” label in 

the lower left hand corner of the 
Description tab to say “Yes” 

     
The “Tags” panel indicates    The “Tags” panel displays 
that no tags available              the tree structure of tags                   

 

 
Reveal the Tags Panel  
Open the Tags navigation panel. If there are 
tags, the tree structure of the tags can be 
seen in the navigation panel.  
 
If there are no tags, the message “No Tags 
available” is displayed. 

 

 
 
 
 
 



 
 

 
 

If it is confirmed the document does not contain a tag structure, tags can be added to the document by 
selecting the option Tools> Accessibility > Add Tags to Document.  

 

     
Accessibility Tools pane            Add Tags Report             
highlighting an option                                                  
to Add Tags to Document 

With this functionality, Acrobat Pro 
automatically inserts tags into the document, 
and generates a report including a confidence 
rating of the generated tags and the tasks you 
must perform manually (like, for example, 
adding alternative text to images). 

 

    

Recheck in the Tags Panel that a tag structure 
has been added to the PDF  

Options Menu> look for “Documents is Tagged 
PDF” option is checked. 

  Tag Tree Structure        Options Menu showing Document is Tagged 



 
 

 
 

Assess Tag Order & Reading Order  
Screen readers and text-to-speech software look at the Tags of a PDF to determine the correct reading 
order of the page. The tags panel displays all the structural elements contained in your document such 
as paragraphs, headings, links, lists, images, etc.  The order in which these items are displayed is the 
order in which they will be read out loud to a user of assistive technology. 

Unfortunately, tags generated during conversion are not always in the correct order.  It is important to 
ensure that the tag order is correct and that tags are not missing.  Begin by opening the tags panel: 

• To view the Tags Panel, select View > Show/Hide > Navigation Panes > Tags.  
• Can also select the Tags pane from the left-side Navigation Pane. 
• The list of tags can be navigated, expanded, and collapsed using a mouse or the arrow keys on 

the keyboard. 

    

           Steps (Menus) to View Tags Panel     Tags Pane 

 
 
 
 
 
 
 
 
 
 
 



 
 

 
 

• To highlight content on our PDF as you click through tag items, you can right click on any tag 
and choose “Highlight Content” or select in the Options ( ) menu.  When a tag is selected in 
the tag tree, its corresponding content will be highlighted on the document. 

     

  Highlight Content Menu      Options Menu 

• If they are not in the correct order, move tags around by clicking on a tag so that it is 
highlighted then drag and drop it to the correct location. 

• A line will appear showing the location where the tag will be moved in the Tag Tree and the 
cursor will change its color to black. 

 

     Tag Tree 

 

To check the Reading Order, use the TouchUp Reading Order Panel from the Accessibility Toolbar. 



 
 

 
 

1. In the Accessibility Toolbar, select the TouchUp 
Reading Order option. 
 

2. In the new window that pops up, check Show 
Page Content Groups> Choose Page Order 
Content> then select Show Order Panel.  

 
3. The Order Panel should show up in the 

Navigation Pane on the left side of the screen. 
 

4. Your page should fill with sections that are 
numbered. If they are not in the correct order, 
Select and Drag.  

   

 



 
 

 
 

 

 
 

1. Check each page in the document. Verify between the document view and the order 
panel that the items are numbered correctly. 

2. After editing the reading order, go back to the Tags Panel and make sure the tags 
panel matches the order panel.  Both Panels should display the same order so that 
the content can be read in the same order.  If it does not, then begin re-ordering 
tags as appropriate. 

 



 
 

 
 

TouchUp Reading Order Tool (Fixing PDFs) 
Once you’ve checked your PDF for accessibility, you can begin to fix it. The report has a lot of 
valuable information including where the problems are and hints on how to fix the issues. You 
can click on the links in the report to view the exact location of the accessibility issues and fix 
the issues that way. Or you can start at the beginning within the tag structure and fix the tags 
first.  

When working in the tags panel you can right click on any tag and choose “Highlight Content” 
or select in the Options ( ) menu. This will help you know where the content is for this tag by 
highlighting the corresponding text, image, or other element in the PDF file. 

Even though the PDF may be tagged, it may be tagged incorrectly. A properly tagged PDF is one 
that has: 

• Heading tags (if the PDF has headings) 
• Paragraph tags for paragraphs 
• List tags for lists 
• Figure tags for images 
• Properly formatted Table tags if the file has tables 
• Correctly labeled form tags if the file has form elements 

Edit tags with the TouchUp Reading Order tool 
You can use the TouchUp Reading Order tool to create tags in untagged PDFs, add new tags to 
an existing structure or to fix basic tagging problems. However, this manual tagging doesn’t 
provide the same level of detail to the tagging structure as the Add Tags To Document 
command, such as paragraphs, bulleted and numbered lists, line breaks, and hyphens. Before 
you clear the existing structure, make sure that manual tagging is your only recourse. 

To open the TouchUp Reading Order tool, select Tools > Accessibility > TouchUp Reading Order 
to select the TouchUp Reading Order tool. 

The TouchUp Reading Order Tool includes the following options: 

• Text. Tags the selection as text.  

• Figure.  Tags the selection as a figure. Text contained within a figure tag is defined 
as part of the image and is not read by screen readers.  

• Form Field. Tags the selection as a form field.  

• Figure/Caption. Tags a selected figure and caption as a single tag. Any text 
contained in the tag is defined as a caption. Useful for tagging photos and 
captions and preventing caption text from being incorrectly added to adjacent 
text blocks. Figures may require alternate text.  



 
 

 
 

• Heading 1, Heading 2, Heading 3.  Tags the selection as a first, second, or third 
level heading tag. You can convert heading tags to bookmarks to help users 
navigate the document.  

• Table.  Tags the selection as a table after the selection is analyzed to determine 
the location of headings, columns, and rows.  

• Cell.  Tags the selection as a table or header cell. Use this option to merge cells 
that are incorrectly split. 

• Formula.  Tags the selection as a formula. Because speech software may handle 
formula tags differently from normal text, you may want to add a description 
using alternate text.  

• Background.  Tags the selection as a background element, or artifact, removing 
the item from the tag tree so that it doesn’t appear in the reflowed document 
and isn’t read by screen readers.  

• Table Editor.  Automatically analyzes the selected table into cells and applies the 
appropriate tags. The table must be tagged as a table before you can use the 
Table Editor command on it.  

• Show Page Content Order.  Shows content elements as highlighted areas that 
contain numbers to indicate the reading order. The rectangle next to this entry is 
a color swatch. Specify the desired highlight color for page content order by 
clicking the color swatch. 

• Show Table Cells.  Highlights the content of individual table cells. The rectangle 
next to this entry is a color swath. Specify the highlight color for Table Cells by 
clicking the color swatch.  

• Show Tables and Figures.  Outlines each table and figure with a crossed-out box. 
The box also indicates whether the element includes alternate text. The rectangle 
next to this entry is a color swatch. Specify the highlight color for Tables and 
figures by selecting the color swatch.  

• Clear Page Structure.  Removes the tagging structure from the page. Use this 
option to start over and create a new structure if the existing structure contains 
too many problems. 

• Show Order Panel.  Opens the Order Tab to allow you to reorder highlighted 
content. 

• Edit Alternate Text.  Available in the menu that appears when you right-click a 
highlighted figure. Allows the user to add or edit a text description about the 
figure properties that is read by a screen reader or other assistive technology. 

• Edit Form Field Text.  Available in the menu that appears when you right-click a 
form field. Allows the user to add or edit a form field text description that is read 
by a screen reader or other assistive technology. 



 
 

 
 

• Edit Table Summary.  Available in the menu that appears when you right-click a 
highlighted table. Allows the user to add or edit a text description about the table 
properties that is read by a screen reader or other assistive technology. 

 

 
TouchUp Reading Order Tool 

 



 
 

 
 

What are Paragraphs? 

A paragraph is a block of text in a document that centers on a specific idea.  

Draw a rectangle around text that you want to label as a Paragraph. 

Select the Text option on the Touch-Up Reading Order Panel (Text and Paragraph are 
synonymous in Acrobat. They both create a Paragraph tag <P>). 

The Paragraph Tag <P> will be displayed in the Tag Tree. 

 

 

 
Figure 1 - Select "Text" in TouchUp Reading Order Tool 

 



What are Headings? 
Headings are text in a PDF that indicates a document title or are used to separate sections of 
the PDF. For documents longer than 3-4 paragraphs, headings and subheadings are important 
accessibility strategies. They help screen readers both determine the overall outline of the 
document and to navigate to specific information that may need more of the screen reader's 
attention. 

Imagine a large cookbook with no table of contents or index. How hard would it be to find a 
specific recipe? 

If you imagine a PDF is a book, then the headings are like the title and chapters in a PDF. 

<H1> headings would be the main title of the PDF.  
<H2> headings would be like the chapters in a book.  
If the book is a textbook, <H3> – H6 are like the sub-headings within chapters.  
The lower the number, the smaller and more detailed a section.  Try to be consistent with your 
sub headings.  

It is important to also apply headings to index and glossary sections. Applying headings to these 
areas will help assistive technology users’ move the cursor to pertinent information without 
having to read other content. 

To tag text as a heading, open your PDF and go to Tools > Accessibility >Touch-Up Reading 
Order Panel 

Draw a rectangle around the text you want to label as a level 1 heading <H1> and select 
Heading 1 on the Touch-Up Reading Order Panel  

Figure 1 – Heading One Example 



 
 

If the “Show Page Content Order” is checked on the Touch Up-Reading Order Panel, then the 
text you just selected should now be highlighted in gray with a number on the left-hand side 
within the contents window. 
 

 
Figure 2 – Heading 1 Example with Show Page Content Order checked and Tag Tree View 
 
To tag as Heading Level 2 <H2> or 3 <H3>, select the Heading 2 or Heading 3 options in the 
Touch Up Reading Order Tool. 
 
To tag as Heading Level 4 – 6, tag as 1 -3, then change the 3 to a 4, 5 or 6 in the tag panel much 
the same way as you would rename a file on your computer. 
 
Note: Ensure that all heading elements are ordered properly. For example, <H2> elements 
should follow <H1> elements and <H3> elements should follow <H2> elements, etc.  
 
Content authors should not "skip" levels (e.g. H1 directly to H3). When headings are incorrectly 
ordered, users of assistive technology may become confused over the structure of the 
document and believe content is missing.  
 
Heading element tags such as <H1> and <H2> etc. should be utilized sparingly and primarily to 
denote important sections within a page/document. Unnecessary use of heading elements 
prevents users with visual impairments from quickly navigating between the key sections of a 
page. 
 



Adding a Document Title 
1. Go to File Menu > Properties 

 
2. Choose Properties under the File Menu 
3. Description Tab > fill in Title (a meaningful title must be given to the document. This title 

must be representative of the content of the PDF file. It is usually the same as the title 
which appears on the cover of the document)  

4. Description Tab > fill in Author (if no author is listed on the PDF use whatever your client 
has told you to use for the default author. If you don’t know, leave it blank. It can be 
changed or filled in later.) 



 
Fill in the Title and Author. Subject and Keywords is optional. 
 



 
 

 
 

What are Lists? 
• A list is text that might be short phrases, single words, sentences or paragraphs grouped 

together as a category.  
• Lists often are numbered with numbers or letters.  
• Lists might have symbols instead of numbers or letters, called bullets.  
• List structures help assistive technology users to identify and understand the relationship items 

have to each other.   
• Occasionally lists have nothing in front of each list item.  
• Try to properly tag lists as lists. 
• List items which are not tagged as list elements may not be rendered properly in assistive 

technology.  
• Authors should ensure that all list items are tagged as list elements within a document.  
• When list items are tagged properly users of screen readers will be able to determine the 

number of items in the list, navigate to each list in the document, and quickly navigate between 
list items.  

• When list elements are not properly tagged, users of assistive technologies are not able to 
detect the hierarchical structure and position of list items.  

The structure types for lists in PDF documents are:  

• <L> - List Tag, which contains one or more <LI> tags.  
• <LI> - List Item Tag. List item tags can contain <Lbl> and <LBody> tags. 
• <Lbl> - List Item Label. Contains distinguishing information such as a item number or bullet 

character.  
• <LBody> - List Item Body. Contains list item content, or in the case of a nested list, it may 

contain additional List tag trees. 

If a block of text should have been tagged as a list, but was not, follow these directions: 

Tag each list item as a paragraph if they are not already tagged as such. 

 
Highlight paragraph with cursor> right click on text> select “Tag as Text” (Text=Paragraph Tag) 
 

 



 
 

In the tag panel, right click on the <P> tag> choose New Tag > List (from the drop down). Select OK. 
 

 New Tag Type List 

Move the List tag above the first paragraph tag by left clicking on it and dragging it to where you want 
to place it. A dotted line with a small black triangle will show up where you’ve chosen to place the tag. 
Release the right mouse button. 
 

Move the List tag above the first paragraph tag 

Next, move each paragraph tag that you just tagged so that it is in order and under the List tag you just 
created and moved. Make sure they are incorporated into the List tag so what when you click the 
minus tag in front of the list tag it hides all of the paragraph tags you just made and becomes a plus 
sign. 

Move paragraph tags under List tag 

Click - to contract and + to expand 

Now rename each of the paragraph tags as a List Item tag. You can either right click on each one 
choose Properties > List Item or rename them by highlighting them and naming them <LI>, much as 
you would rename a file on your computer. 
 
 
 
 



 
 

 
Choose List Item from drop down list 

 
Rename paragraph tag as List Item 

Tag the symbol in front of each list item, if one exists, as a paragraph, then tag that as a list label 
(<Lbl>) and then tag the actual list item as a list body (<LBody>). Place the list label and list body tags 
under a List Item tag. Often when the program tags lists, it does it this way. 

 
Structure of a list of four items 

Below is an example of proper list structure: 
Example List and List Structure: 

• U.S. passport  
• DHS “Trusted Traveler” cards (NEXUS, 

SENTRI, FAST)  
• Driver’s licenses or other state photo 

ID cards issued by the Department of 
Motor Vehicles (or equivalent)  

• Transportation Worker Identification 
Credential (TWIC) 



 
 

Ensure sub-lists are structured properly 
A sub-list must be structurally under, as a child, the list item to which it is related. It is placed 
after the text of the parent list item. Below is an example of a sub-list structure: 

 
Pay attention to lists that span across multiple pages. Even though a list continues on to 
another page, it is important that in the tag structure those list items are part of the original list 
and not a list of their own. Attention to detail of these items enables users to associate related 
content and know the total number of related items. 
 



 
 

 
 

Specifying a Document Language 
Adding the main document language in the document properties enables voice synthesizers in 
screen readers to correctly pronounce the document content.  

To rename the Document Language, go to the Document Properties dialog box (File > 
Properties via the menu bar), select the Advanced Tab, and then choose the Main Document 
Language in the Language drop-down list near the bottom of the dialog box. 
 

 

Select Ok & Save file. 
  



 
 

 
 

Set Page Structure to Document Structure 
1. Select all the pages in the page Thumbnails Panel  
2. Select Page Properties (right-click) 

 
 

Under Tab Order select Use Document Structure  

 
3. Select OK 

 



Creating Accessible Links 
1. Locate an area of a page where you want to add a link then select Tools > Content Editing > Add

or Edit Link.

2. The pointer becomes a cross hair, and any existing links in the document, including invisible
links, are temporarily visible.

3. Drag a rectangle where you want to create a link. This is the area in which the link is active.
4. In the Create Link dialog box, choose the options you want for the link appearance.

5. Choose an action that the link will perform:
• Go to a Page View: This option is the default, where you can scroll to the page that is

the destination of the link.
• Open a File: Alternatively, you can choose to link to another file; click the Browse button

to locate the file.
• Open a Web Page: If you choose this option, you’re choosing to link to a web address. In

the Address text box, enter the complete address of the web site to which the link
should direct viewers. To create a link to an e-mail address, type mailto: followed by an
e-mail address. (Note that mailto: is all one word.)



• Custom Link: Use this option to choose from other types of links in the Link Properties 
dialog box. 

6. Select Next button and follow the instructions in the next dialog box before clicking OK. 

To add the Link-OBJR tag to a link for keyboard accessibility: 
1. Locate the tag containing the visual link text in the Tags pane. This will allow the tag to be 

placed in relation to its link text. 
2. Activate the Context menu (right-click) of the Link Text tag and select Find… 
3. In the Find Element dialog, select Unmarked Links from the Find combo box. 

 
4. Navigate to and activate the Find button. 
5. When the link in question is highlighted in the main document by a blue rectangle, navigate to 

and activate the Tag Element button. 
6. Navigate to and activate the Close button. 
7. Confirm a Link-OBJR tag has been placed as a sibling tag to the Link Text tag. 

 

Removing Links 
1. Select Tools > Content Editing > Add or Edit Link (which has a chain-link icon).  
2. Right click once on the hyperlink that you want to delete.  
3. Choose “Edit” drop-down menu, and select the “Delete” option. This will remove the link. 

The blue border around the link will be deleted.
 

 
 



 
 

 
 

Data Tables (Simple or Complex) 
Often tables are used in two ways: for layout purposes and to organize and display associated data. 
The use of layout tables should be limited. Layout tables can cause navigational issues for AT users. 
Layout tables should not contain data table structure, such as table header (TH) tags, for headers. 

There are two types of data tables: simple and complex. Simple data tables have a one-column header 
to one-row header ratio. Complex data tables have two or more levels of row and/or column headers 
that must be associated to make sense. The following are some important keys to creating accessible 
data tables in Adobe Acrobat PDF documents: 

 Ensure data tables are formatted using table elements. 
 All data tables should use TH tags to identify header cells. 
 Define column headers across page breaks. 
 Associate table row and column headers with data cells. 
 Place content that is in separate rows and columns into separate data cells. 
 Merged row and column headers need to have RowSpan or ColSpan defined. 

Table Structure 
Using the below example of a three-column, two-row table, the structural elements and nesting of tags 
can demonstrate what the final proper structure of a table needs to appear as in the Tags pane. 

Example Table: 

Header 1 Text Header 2 Text Header 3 Text 

Row Header Text Column 2, row 2 data cell text Column 3, row 2 data cell text 

Example tag structure: 
 <Table> - Element definition, a table.  
 <TR> - Table Row  
 <TH> - Defines a table header cell  
 Header 1 text  

 <TH> - Defines second column header 
cell  
 Header 2 text 

 <TH> - Defines third column header 
cell  
 Header 3 text 

 <TR> - Table Row  
 <TH> - Defines the row header cell  
 Row header text 

 <TD> - Defines a table data cell  
 Column 2, row 2 data cell text 

 <TD> - Defines a table data cell  
 Column 3, row 2 data cell text 

 



 
 

 
 

For simple data tables where there is a one-to-one relationship between a data cell and a 
row/column header, the Scope attribute can be used to associate the header with the cell. This 
tells a screen reader that it is to associate row/column headers with the cells in that 
row/column.   
 
Recommended Approach: Using the Table Editor: 

1. Activate the TouchUp Reading Order tool under Accessibility in the Tools pane. 

2. Highlight the table and select the Table option in TouchUp Reading Order Tool. 
3. Activate (right-click) the Context menu on the newly tagged Table. 

 
4. Select Table Editor. 

 
5. Activate (right-click) the Context menu on the table header cell that needs to be marked 

as a header. 
6. Select Table Cell Properties.  

 
7. Confirm the Table Cell Properties dialog appears. 



 
 

 
 

8. Select the Header Cell radio button under Type in the dialog. 

 
9. Select the appropriate Scope - Row, Column or Both from the Scope combo box. 
10. Navigate to and activate the OK button. 
11. Repeat the process for each row and column header. 

Complex Data Tables 

The table below is a complex table listing employees and their status on projects. The table is a 
good example of complexity because the project titles are merged cells, with status definitions 
under each. Each employee’s status on a project is related to “Started” or “Completed” and the 
project title. 

 
Employee 

Project A Project B Project C 

Started Completed Started Completed Started Completed 

Maria Yes Yes Yes No No N/A 

John No N/A Yes Yes Yes No 

Jessica Yes No No N/A No N/A 

Complex tables, such as the one above, need ID and Header arrays to associate data cells with 
headers. Each header (TH) will be assigned a unique ID and each data cell (TD) will have an 
array that includes all of the ID values of the applicable header cells. There are two methods to 
properly associate the cells: using the Table Editor features (recommended) or editing the 
properties of each cell through the Tags pane. The steps for both methods are explained below: 



 
 

 
 

Setting the ID using the Table Editor: 

1. Activate the TouchUp Reading Order tool under Accessibility in the Tools pane. 
2. Activate (right-click) the Context menu of the table. 
3. Select Table Editor. 
4. Select the table header cell to mark as a header and activate the Context menu. 
5. Choose Table Cell Properties… 
6. Ensure the Header Cell radio button is selected. 
7. Select Row, Column, or Both from the Scope combo box. 
8. Adjust the values in the Row Span and Column Span edit boxes as necessary. 
9. Enter a unique value in the ID field that identifies this header cell. 

 
Note: The value entered is not what will be read to the assistive technology user. It is 
basically a behind the scenes code name for the visually displayed content. The trick is 
to remember the unique value so that it can be associated with the correct content in 
later steps. 

10. Activate the OK button. 
11. Repeat for each table header cell. 

Setting the Headers Array for each Data Cell: 

1. Activate the TouchUp Reading Order tool under Accessibility in the Tools pane. 
2. Activate (right-click) the Context menu of the table. 
3. Select Table Editor. 
4. Activate (right-click) the Context menu of a data cell. 
5. Select Table Cell Properties… 
6. Ensure the Data Cell radio button is selected in the Table Cell Properties dialog. 
7. Adjust the values in the Row Span and Column Span edit boxes as necessary. 

8. Navigate to and activate the Add button  for the Associated Header Cell IDs” list 
box. 

9. Select the matching header cell ID from the Header ID: combo box in the Add Table 
Header ID dialog. 

 
IMPORTANT: Select the header IDs in such a manner that the order in the list box from 
top to bottom will be the reverse order in which the headers should be read. Using the 
example table above, the visually implied reading order of the headers for the first data 
cell would be Project A, Started, Maria; therefore, the first item in the list box needs to 
be Maria. 

10. Navigate to and activate the OK button. 



 
 

 
 

11. Add additional header attributes, as needed, for each cell that has multiple headers. 
12. When all header IDs have been added, all associated row and column headers should be 

listed in the Associated Header IDs list box. 

 
13. When finished, navigate to and activate the OK button of the Table Cell Properties 

dialog. 
14. Repeat the steps above for each table data cell. 

Spanned Cells 
It is crucial that spanned table headers and data cells have the appropriate ColSpan or RowSpan 
attributes applied for screen readers to properly interpret the information. Setting the proper 
value for ColSpan and/or RowSpan for header content that spans across multiple columns or 
rows allows AT to identify the correct header name to the user. 

Updating Row Span and Column Span through the Table Editor: 

1. Activate the TouchUp Reading Order tool under Accessibility in the Tools pane. 
2. Activate (right-click) the Context menu of the table. 
3. Select Table Editor. 
4. Activate (right-click) the Context menu. 
5. Choose Table Cell Properties… 
6. Ensure the Header Cell radio button is selected. 
7. Ensure the proper value is selected in the Scope: combo box, either Row, Column or 

Both. 
8. Adjust the values in the Row Span or Column Span edit boxes as necessary. The value in 

the edit field needs to equal the number of columns or rows that the text and cell 
boundaries spread across. In the example table used in the Complex Tables section, 
Project A spans two columns (Started and Completed); therefore, the value in the Col 



 
 

 
 

Span edit field for the Project A cell would be 2. 

 
9. Navigate to and activate the OK button. 
10. Repeat for each spanned table cell. 

Adding a Table Summary 
A table summary is optional and can improve accessibility by providing the user with a very 
brief overview of what information is to follow in the data table. It is not necessary to repeat 
the actual data in the table summary; rather, it is a brief synopsis that contains a summary of 
the way the table is laid out to give the user a preview of what information the table 
communicates. The table summary is not viewable in the PDF document, but is designed to be 
spoken to an individual using assistive computer technology. To create a table summary: 

1. Select the TouchUp Reading Order Tool 
2. Locate the table and right click on the item block (table) 
3. From the menu select Edit Table Summary.  The Table Summary box displays. 

 
4. In the Table Summary box type a description of the table 
5. Click the OK button. 

 



 
 

 
 

Headers and Footers 
Headers and footers contain important pieces of information that need to be readable by all 
users. However, when users of screen reading technology hear this content, it can be confusing 
to discern which information is part of the main page content versus which information is part 
of the header and footer information. 
 

 

The example above shows how, depending on the context of the content, it could be confusing 
to understand the point being conveyed by the information. The image shows a document that 
has a sentence that breaks across pages.  
 
The page content shown improperly reads “...Development of new capabilities and sustainment 
FY 2012 Frequently Asked Questions: TSGP 2 of existing capabilities to enhance visible……” The 
correct information and intention of the sentence is misconstrued when read in that order.  
 
The sentence should read “……Development of new capabilities and sustainment of existing 
capabilities to enhance visible……….” Therefore, repetitive header/footer content needs to be 
made an artifact.   
 
Repetitive header/footer content, for example, the repeated company name on each page, 
needs to be tagged only on the first page.  
 
It is recommended to leave the content visually on the page, but to tag the repeated content as 
an artifact. For unique content such as notes, footnotes, remarks, etc., the content needs to be 
placed appropriately in the reading order. 
 



 
 

 
 

Adding Alternative Text to Figures (Images) 
A figure is an image. This might be a drawing, a photograph, a screen shot or a graphic chart such as a 
pie chart or bar graph. Sometimes the figure is important and other times it doesn’t add anything to 
the document. For instance a drawing of a bowl of flowers usually will not be important and will not 
need to be tagged as an image (although it will need to be tagged as an artifact or background). You’ll 
need to make the decision as to whether or not the image is important. Most of the time, when you 
add tags to a document, or when they are tagged from another source such as Microsoft Word, the 
images will already be tagged as figures. In this case, all you’ll need to do is add alternative text. 

To tag content as a figure: 

• Open the Touch-Up Reading Order Panel - Tools> Accessibility> TouchUp Reading Order 
• Draw a rectangle around the content you want tagged as a figure. 
• Then in the Touch-Up Reading Order Panel, select “Figure”. 
• If the content is a figure with associated text, you can click “Figure/Caption” and the text will be 

given the caption tag within the figure tag. 
 

 
              TouchUp Reading Order Tool showing Figure option 

After tagging the content as a figure you’ll need to add alternative text for users who are not able to 
see the image/graphic. Describe the image as if you were talking to someone on the phone and had to 
describe an image to them and they did not have a copy in front of them. Charts and graphs will have 
to be described in detail and objectively.  

 

 



 
 
Alternative text for the FEMA figure above could be: 
“U.S. Department of Homeland Security Seal, Federal Emergency Management Agency Logo. 

 

Usually if you double-click on the image you’ll see an option in the pop-up menu that says “Edit 
Alternate Text” or you can select the number associated with the Figure (in the top left hand corner) 
and the then right-click to open the context menu – select “Edit Alternate Text” option. 

 

A small text box will open up and you can type or paste your alternate text into the box. There is no 
character limit when adding alt text. Click OK after adding the alternate text. 
 

 

 

 
 



 
 
A much more difficult alternate text to write is when you’re writing alternate text for a chart or graph. 
Unless the chart or graph is thoroughly described in the text of the document, you must write very 
descriptive alternate text for the figure/image.  

An example of line graph whose alternate text 
could be: 

“A line chart titled Figure 1 Promotional Spending  
by Type of Marketing Activity, 1989 to 2008. Along 
its horizontal axis are years running from 1989 to 
2007 in increments of 3 years. Along its vertical  
axis are numbers 0 through 12 indicating billions   
of dollars. The line labeled Detailing Health Care 
Professionals steadily rises from 2.8 billion in 1987 
to 12 billion in 2007 with a plateau between 1992  
– 1995 & 2002 & 2004. The line labeled Meetings 
and events steadily rises from 0.7 billion in 1993   
to 2.8 billion in 2008. The line labeled DTC (direct 
to consumer) advertising starts at 0.5 billion in 
1995 and generally rises with to 4 billion in 2006 
but falls to 3.8 billion by 2008”. 

While it seems long for alternate text, there is no 
other way to describe an important image in an 
extant PDF file. Please note that the text below the 
file is assumed to be in text format, so does not 
need to be in the alternate text. If it were part of 
the photo it would need to be included as alternate 
text. 

 



 
 

Below is a pie chart whose alternate text could be: 
 
“A pie chart titled European Parliament election, 2004 and divided into 8 wedges. Clockwise 
from the top of the chart the wedges and their percentages are PES 27%, EUL 5%, Other 9%, 
UEN 4%, EPP 38%, ELDR 9%, EDD, 2%, EFA 6%”. 
 

 
Pie chart of the European Parliament election, 2004 
 
 



 
 

 
 

Hide or “Artifact” Non-Meaningful Content 
Creating artifacts in Acrobat can be crucial to the accessibility of a PDF document. There are 
times when content on a page is used to visually cause an effect (separation, borders, 
decoration, etc.). However, when these items are exposed through the tag structure to assistive 
technology (AT) users, it can be quite disruptive. Hiding or changing content to be an artifact 
(the term used within Adobe Acrobat) can help ensure that only meaningful content is detected 
by assistive technology. 

Examples of content that should become artifacts are: 

• Unmarked content 
• Drawing remnants 
• Decorative images 
• Redundant and duplicate information repeated on every page, such as header or footer 

content, line spacers and other content that is meant to be visually appealing, but not 
to provide pertinent information.  

• Any tagged content that is not tagged as an artifact will be identified by assistive 
technology. 

Creating an Artifact 
There are two ways to artifact or hide content from screen readers. 

Recommended Approach: Change the content to an artifact through the Context menu options 
of a particular tag in the Tags Tree. 

1. Find the content in the Tags Tree that needs to be hidden. 
2. Activate the Context menu (right-click) of that specific tag. 
3. Select Change Tag to Artifact... from the menu options. 

 

 



 
 

 
 

4. Select the OK button in the Create Artifact dialog. 

 
5. Repeat steps 1 through 4 as many times as necessary. 

 
Check that the text and/or remnants are not present in the document by highlighting the 
content in the main document and selecting <Find Tag from Selection> on the Context menu of 
any tag in the Tags tree. A dialog box should pop up stating that the selection was not found. 
Alternatively, a screen reader can be used to read through that section of the document to 
ensure the content is hidden. 

The second method to hide or artifact content is to use the TouchUp Reading Order tool. 
1. Select the content in the main document that needs to be hidden from ATs. 
2. Activate TouchUp Reading Order tool; select Tools from the right-hand menu, then 

select Accessibility > TouchUp Reading Order. 
3. In the TouchUp Reading Order dialog, activate the Background button. 
4. Repeat steps 1 through 3 as many times as necessary. 

 

 



 
 

Color Dependence 
Determine if color is used as the only means to convey pertinent information.  In instances 
where color-only is used, text also needs to be provided that describes the information being 
presented in color.  For example, the words High = Green, Medium = Yellow and Low = Red 
need to be provided to convey the threat level. 

In the table below, the DC WMATA Metro has identified their stations with the colors red, 
orange, blue and yellow circles to represent the metro lines available in Washington DC.   

 
 
Metro Table Showing Metro Lines Using Color Alone 

The Legend below shows the words to indicate what each color graphic means.  This ensures 
everyone knows the information that is being conveyed and it is accessible for users who are 
not able to see. 
 

Legend - Graphics such as the colored circles represent the Metro lines available at each 
station. 

Red Line  · Glenmont to Shady Grove  
Orange Line  · New Carrolton to Vienna/Fairfax-GMU  
Blue Line  · Franconia-Springfield to Largo Town Center  
Green Line  · Branch Avenue to Greenbelt  
Yellow Line  · Huntington to Fort Totten  

 
Each grahic requires alternative text to be added by right clicking on the image and selecting 
Edit Alternative Text.  Please refer to the “Adding Alternative Text” Resource for more 
guidance. 
 



 
 

 
 

Accessible Fillable Forms 

Creating a Form 
The Form Wizard in Adobe Acrobat XI Pro can be used to create interactive forms from an existing 
electronic document (for example a Word, PDF, or Excel document) or from a paper form that was 
placed in a scanner with the resulting image opened in Acrobat. Authors can also create forms 
manually in Acrobat, or individually add form fields to an existing document using the form tools. 
 
Acrobat’s automatic form field detection will attempt to locate any labels that are adjacent to the form 
field (text, check box, etc.) and use any labels it finds as the source for the accessible label (the form 
field tooltip in Acrobat).  
 
A form element and form objects for each field will be created in the Tags pane as part of this process. 
Examine the document carefully to verify that Acrobat accurately detected the fields and labeled them 
properly.  To make an electronic form fillable with the wizard: 
 

1. Display the Forms Pane  
Select View Menu > Tools > Forms  

 
Create Form Command in the Forms Task Pane 

2. Select the Create command  
3. The Create Form dialog is displayed  

 
 
 
 
 
 
 
 
 



 
 

 
 

 
          Acrobat XI Pro Create Form Dialog 

 
    

From the Create Form Dialog, select one of the following options and then follow the on-screen 
instructions: 
 

Use an Existing File 
This option converts an existing electronic document (for example Word or PDF) to an interactive 
PDF form. To use the document that is currently on display, select “Next” and the “Use the current 
document” option. Select “Next” again. Acrobat automatically searches for and creates any form 
fields it detects, and places the document in Form Editing Mode.  
Scan a Paper Form 
This scans a paper form and converts it to a PDF form. The form will be scanned, converted to PDF 
and Acrobat will search for and create any form fields it detects. The form is placed in Form Editing 
Mode  
Create a Form from Scratch or Using a Template 
This creates an Online Form using Adobe FormsCentral. Adobe FormsCentral provides a simple 
interface to create interactive forms for collecting data online. FormsCentral is not addressed in 
this document.  

When either the “Use an Existing File” or “Scan a paper form” option is chosen, Acrobat XI Pro analyzes 
the document, adds any detected form fields, and puts the document in Forms Editing Mode. The 
document will look similar to what is shown below. From here, you can add, edit or delete the 
automatically created form fields. 

 
 
 
 
 
 
 
 
 
 



 
 

 
 

 
    Event Registration Form Image 
 
Acrobat XI Pro Forms Editing Mode 
During form field detection, Acrobat may have missed some fields, or created unnecessary ones. It may 
also have created fields of the wrong type. Verify the fields and field names on the form. Add New 
Field on the Forms Editing toolbar can be used to add more fields. You can also right-click on the form 
to add, edit, or delete fields. 

Creating a Form without the Forms Wizard 
Form Editing Mode can also be enabled without using the Form Creation Wizard. 

1. Select View Menu > Tools > Forms and select the Edit command under the Forms Tool Pane  
The Keyboard shortcut is Shift + Ctrl 7.  

2. The Add or Edit Form Fields dialog is displayed if form fields have not been added to this 
document. 

 
       Acrobat XI Pro Add or Edit Form Fields Dialog 

 

 

 



 
 

 
 

Answering “Yes” to the Add or Edit Form Fields dialog question “Do you want Acrobat to detect form 
fields for you?” causes the automatic detection of form fields prior to placing the document in Form 
Editing Mode. This is the same as running the Form Wizard.  

Acrobat will analyze the document, add detected form fields and put the PDF form in Forms Editing 
Mode. From there, you can edit the automatically created fields or add new ones.  

Answering “No” to the Add or Edit Form Fields dialog question “Do you want Acrobat to detect form 
fields for you?” also places the document in Form Editing mode, but does not create form fields 
automatically. Form fields will have to be added manually.  

Creating Form Fields Manually 
If you answer “No” to “Do you want Acrobat to detect Form Fields for you?” the document enters 
Forms Editing Mode without automatically creating any fields.  

To add new form fields to the PDF, select one of the options from the Add New Field drop-down menu 
that presents the eight possible Acrobat field types.  
 

To add the fields to your form document: 

 

• Select “Add New Field” under the task pane. 
• Or click on the type of form field you want to 

add from the Forms Toolbar 
• Bring your cursor to where on the document 

you want the field to appear 
• Click to place the form field or drag to “draw” 

the field on your document 
Or 

• When you are done a new Field Name dialog 
box opens 

Each field needs to be named descriptively and uniquely. The field name pop up box allows you to 
name the field and Show All Properties if you want to add or change other field properties. 

Forms Editing Mode 
In Forms Editing Mode, you can add, edit or delete any existing form object. The Acrobat XI user   
interface changes when in Forms Editing Mode. The Forms Editing Toolbar appears and provides access 
to the Select Object tool, the Add New Field buttons for each field type, and the Form Preview button. 
On the right hand side of the Forms Editing Toolbar, beneath the Tasks pane, the Add New Field, 
Distribute, Track, and Other Tasks commands are displayed. The Fields pane shows any interactive 
fields that are currently part of the form. You can exit this mode by selecting the Close Forms Editing 
button above the Tasks pane. 



 
 

 
 

Selecting a New Form Field to Create 

In Acrobat XI Pro, a form field can be created by choosing one of the form tools. For each field type, it 
is possible to set a variety of options through the form field Properties dialog box.  
The forms tools can be accessed in one of three ways:  

1. Select “Add New Field” under the task pane. 

  
Acrobat XI Add New Field Command 
 

2. Select one of the commands from the Forms toolbar that appears below the Acrobat XI Pro 
menu bar. 

  
               Forms Toolbar in Acrobat XI Pro Menu Bar 

3. Right click over the form to add new fields. 

 
Adobe Acrobat XI Right Click Forms Dialog 

 

 

PDF form created with Adobe Acrobat XI Pro’s forms editing tools can contain the following types of 
fields: 



 
 

 
 

Field type Description 
A. Text field Allows the user to type in text, such as name, address, or phone 

number. 
B. Check box Presents yes-or-no choices for individual items. If the form contains 

multiple check boxes, the user can typically select as many or few of 
these as needed. 

C. Radio button Presents a group of choices from which the user can select only one 
item from the group. All radio buttons with the same name work 
together as a group. 

D. List box Displays a list of options the user can select. List boxes have a field 
property that lets the user Shift-click or Control-click to select multiple 
items on the list. 

E. Combo box Allows the user either choose an item from a pop-up menu or type in a 
value. 

F. Button Initiates a change on the user’s computer, such as opening a file, 
playing a sound, or submitting data to a web server. These buttons can 
be customized with images, text, and visual changes triggered by mouse 
actions. Action buttons are different from radio buttons, which 
represent data choices made by the user. 

G. Digital 
signature field 

Allows the user to electronically sign a PDF document with a digital 
signature. 

H. Barcode 
 

Encodes the input form selected fields and displays it as a visual 
pattern that can be interpreted by decoding software or hardware 
(available separately). 

I. Keep tool 
selected 

Allows you to create multiples of the same field type 

Positioning and Naming the New Form Field 

Once a form tool has been selected, a crosshair cursor appears, and a blue region defines the outline of 
the form object selected for placement. 
 

• On the page, click where the field is to be added. A field with a default size. To create a field 
using a custom size, drag a rectangle to set the dimensions of the field.  

• In the Field Name box, type the name of the field. Select a name that is relevant and descriptive 
to make organizing and collecting the data easier. This name is not shown to users of the form. 

 

 
Field Name Box 

 



 
 

 
 

To test the form, select the Preview button at the top of the document window. Preview lets you view 
a form the way a form recipient would, and gives the author a chance to verify the appearance and 
behavior of the form. If a form is being previewed, click the Edit Layout button to return to Forms 
Editing Mode. 

Next, set the accessible name for the field. This is how the field will be announced by assistive 
technology. Other properties such as required field notation can also be set here. 

Form Field Properties 

 
The dialog boxes for the field properties are content sensitive, so different boxes will be available or offer different options depending on 
the field you have chosen to add. Field Properties box offers different tabs to choose from offering different design attributes. 

How a form field behaves is determined by settings in the Properties dialog box for that individual field. 
Properties can be set that apply formatting, determine how the form field information relates to other 
form fields, and impose limitations on what the user can enter in the form field, trigger custom scripts, 
and so forth. 

To modify a field’s properties, right-click it (or select and then press the Application key). 
A variety of properties can be set for an Acrobat form field, depending on the form field type. The 
properties for each type of form field are selected on a series of tabs. When a property is changed, it is 
applied as soon as another property is selected or when Enter is pressed. 

All form field types have a General tab, Appearance tab, and an Actions tab. Other tabs appear only in 
specific types of form fields. The Options tab appears for most form field types, but the options 
available are unique to each type of form field. You can leave the Properties dialog box open if you 
want to change multiple fields at once.  

 
 
 



 
 

 
 

Setting Tooltips for Form Fields 

The tooltip field on the General tab of the field properties dialog is the most important item for 
form fields. The content of the tooltip will be announced by screen readers as the accessible 
name of the field. This property provides the user with information and instructions about the 
field.  
 
Tooltips should be short and descriptive and should not include the type of field or text such as 
“Click to enter”. For example, “First Name” would be a good tooltip for a first name field and 
“Sign-up Date (2 digit month / 2 digit day / 4 digit year) would be a good name for a “Sign up 
date” field that had a required field format. The City field for a group of shipping field would 
need to include the group name as well as the on-screen label, “Ship to City” or “Shipping 
Address City”.  
 
Note: The tooltip also displays text that users may find helpful in filling in the form field. 
Tooltips appear when the pointer hovers briefly over the form field.  
 
To set the tooltip property of a form field: 

1. Ensure Forms mode is active> Activate Forms Tool > Edit  
2. Ensure that the Select Object tool is selected from the toolbar 

Open the field properties dialog. Double-click a selected form field; or 
Right click or select and press the applications key and select properties; or 
Select the desired field and press the shortcut keystroke (Control + I). 
 
Enter a short and concise label into the tooltip field. The tooltip should provide any group label 
for a group of fields along with the field’s label (refer to the special instructions for radio 
button groups in the next section Tooltips for Radio Buttons). 
 

 
         Adding a Tooltip to a Form Field 



 
 

 
 

Tooltips for Radio Buttons 

To create a radio button group, where only one field can be selected at a time, assign each field 
the same name and the same tooltip, but provide different Button Choices (values). The radio 
button choice is a field in the Options tab of the Radio Button Properties dialog. The tooltip and 
button value will be announced to users of assistive technology for each radio button.  
 
When the same radio button name is assigned to a radio button, the tooltip field should 
automatically be populated with the tooltip text from the other radio buttons in the group. 
(Refer to “Figure 10. Identical Name and Tool Tip Value for a Radio Button Group” on page 10). 

For example, create a radio button group that asks the question, “Conference Pass”. 
Create four radio buttons. For each button, choose to give the button the identical name, 
“Conference Pass.” For each radio button, the identical text appears in the Tooltip field, such as 
“Conference Pass”. 

 

Setting Identical Name and Tool Tip Value for a Radio Button Group 
For the button next to the label indicating “1-day Pass”, enter “1-day Pass” in the Radio Button 
Choice field under the options tab in the Radio Button Properties dialog. 

 

Editing or Modifying an Existing Form Field 

Acrobat form field properties can only be accessed in editing mode (by choosing Forms > Add 
New Field or Edit Fields). Properties for multiple form fields can be set at once.  

• To edit multiple form fields, select the fields to edit. 
Hold down control and click each field to select  

Right-click/Control-click one of the selected fields, and choose Properties.  
Change the properties on each of the available tabs, as needed. The property is 
changed as soon as another property is selected or Enter is pressed. 

Activate the Close button or press enter to close the Properties dialog box.  
 
 
 



 
 

 
 

 
If form fields are selected that have different property values, some options in the Properties 
dialog box are not available. Otherwise, changes to the available options are applied to all 
selected form fields.  
 
To avoid accidental changes to the form field, select Locked in the lower left corner of the 
Properties dialog box before it is closed. To unlock, click the check box again.  

Field Actions  

There are many different actions that can be associated with a form field. These include actions 
based on mouse entry, mouse exit, mouse up, mouse down, on focus, and on blur. It is 
important to note that mouse-only actions will not be keyboard accessible. All functionality 
must be keyboard-accessible without requiring the use of a mouse. The “on focus” and “on 
blur” actions are triggered when the field receives or loses focus respectively. These actions 
should be used with caution. The “on focus” action must not move focus to another field unless 
the field is not to be used, and these actions must not be used to trap the keyboard focus 
within certain fields.  
 
The user must be able to navigate past form fields without having the keyboard focus trapped. 
This is a requirement because many keyboard-only users, including users of assistive 
technology, use the <Tab> or <Shift + Tab> keystrokes to explore the fields of a form and 
discover what options are available. For the same reason, the option “Commit value 
immediately” should be avoided for the dropdown and list fields. Users of assistive technology 
often use the Up and Down arrows to explore or navigate to items in these fields, so changing 
values using these keystrokes can prevent them from using the form properly.  

Set the Tab Order  

If a PDF document does not have a specified tab order, the default order is based on the 
document structure, unless the user has deselected the Tab Order option in the Accessibility 
preferences. The tab order can be changed after the form has been created. It has the following 
options: 
If Forms Editing mode is active, the order can be set to document structure (default), row, or 
column.  

• The order can also be set manually by dragging and dropping fields in the Fields pane.  
 

• If Forms Editing mode is not active, the order can be set in page properties by row or 
column. However, the tab order cannot be set manually.  
 

To change the tab order, first select “Order Tabs Manually” from the Tab Order button on the 
Fields pane. Then fields can be dragged and dropped where appropriate within the Fields pane 
to modify the tab order.  
 



 
 

 
 

To assist in determining tab order, select “Show Tab Numbers” from the Tab Order button 
menu of the Fields pane.  To see the relationship between items in the Fields pane and the 
Document pane. Note also the Order Tabs Manually and the Show Tab Numbers options are 
highlighted. 
 

 
                    Rearranging Tab Order with the Fields Pane  

Provide Instructions and Onscreen Labels  

It is important to ensure that all form fields have instructions or labels. Form instructions are 
typically be placed above the form, call out required fields, and provide additional information 
on completing and submitting the form. Individual form fields typically have labels above or to 
the left of the form field, with the exception of radio buttons and checkboxes, whose labels 
should appear to the right of each field. Labels should contain any formatting information, such 
as value length or date format. 



 
 

 
 

Table of Contents 
Table of content (TOC) structures aid in intra-document navigation and content relation. TOCs 
have the same basic structure as a list; the main difference is that the tags are defined 
differently. 
 
Planning the Structure of TOCs 
Table of contents items need to be structured with <TOCI> tags nested under a parent <TOC> 
tag. Beneath the <TOCI> tag the item description, leader and page number need to be present. 

It is recommended that lengthy documents (20 or more pages) contain a linked table of 
contents. For linked TOCs, each table of content item (TOCI) needs to contain: 

1.  A <Reference> tag.  
2. A <Link> tag needs to be placed as a child element under the <Reference> tag so that 

the item is associated to a content type.  
3. Underneath the <Link> tag the item description, leader, page number.  
4. Link - OBJR tag (which allows for keyboard accessibility) need to be present. 

 
To organize the content in the Tag Tree, each segment of the <TOCI> should be separated into 
its own tag. The segments can be created by highlighting the desired text in the document and 
selecting Create Tag from Selection on the Context menu of the tag (right-click) in the Tags 
pane directly above where the tag is to be placed. 
 
Ensure Table of Contents Lists are Structured Properly 
Creating a table of content structure is very similar to creating a list structure. For the purposes 
of this tutorial, focus will be on creating a linked tabled of contents. Below are the steps to 
create a TOC structure in the Tags pane.  

1. If there is a heading, such as Table of Contents above the TOC items, select it in the main 
document.  
• In the Tags pane, activate (right-click) the Context menu of any tag and select Find 

Tag from Selection. 
• The heading may be contained within part of the TOC structure. If it is, it needs to be 

moved above the parent <TOC> tag and defined as a heading. 

 
Change the <TOCI> tag to a heading by activating (right-click) the Context menu of 
the tag and navigating to Properties. In the Type combo box on the Tag tab, select 
an appropriate heading level and then close the dialog. 

2. If there is no heading above the content items, select the first list item that is part of the 
TOC in the main document. 



 
 

 
 

3. In the Tags pane, activate (right-click) the Context menu of any tag and select Find Tag 
from Selection. 

4. Locate the highlighted tag in the Tags pane and identify whether the content is already 
encased in a TOC structure by locating a <TOC> tag with <TOCI> tags nested below it. 

If a TOC structure is found, it will likely need some remediation efforts. For example, one 
possible structure found after conversion from an authoring tool presents a <TOC> tag with 
a nested <TOCI> tag, a further nested <Reference> tag, the item content, leader and page 
number contained as one item under the <Reference> tag, and finally a Link-OBJR tag as a 
sibling tag to the item content tag.  
1. To remediate the structure for the first item in the TOC that already has a <TOCI> tag, 

ensure a <Reference> and <Link> tag are both present as children tags under the <TOCI> 
tag. 

2. If either or both the <Reference> or <Link> tags do not exist, activate the Context menu 
of one of the tags nested beneath the <TOCI> tag (such as the content item tag) and 
select New Tag… 

3. In the New Tag dialog, select <Reference> or <Link> from the Type combo box. 
4. Navigate to and activate the OK button. 
5. Repeat the above steps to add another tag if necessary. 
6. Verify all the pieces are available to start organizing the structure of a content item. A 

<TOC>, <TOCI>, <Reference>, <Link>, content item, and Link-OBJR tags need to be 
present, 

7. If necessary, highlight the <TOCI> and drag it to become a child of the <TOC> tag. An 
arrow pointing right with a horizontal line to the right side should appear to help 
identify at which level the tag is being placed. 

 
8. If necessary, highlight the <Reference> tag and drag it to become a child of the <TOCI> 

tag. 
9. If necessary, highlight the <Link> tag and drag it to become a child of the <Reference> 

tag. 
10. If necessary, highlight and drag the content item, leader and page number tag(s) to be 

children of the <Link> tag.  
• If the content item, leader and page number are grouped as one tag, they need to 

be separated. To separate the pieces into three separate tags, select the content 
item in the main document. 

• Find the tag containing the content item in the Tags tree and activate the Context 
menu of the tag (right-click). 

• Select Create Tag from Selection on the Context menu (right-click). 



 
 

 
 

 
• Verify the content item is contained in an individual tag. 
• It is likely easier to select the page number than the leader. Therefore, the next step 

is to select the page number in the main document. 
• The page number may not be visible as part of the tag in the tag structure, but find 

the tag near the content item that was just separated that contains the leader and 
activate (right-click) the Context menu of the tag. Select Create Tag from Selection 
on the Context menu. 

• Verify the page number is now contained by itself in a tag. The leader should now 
also be the only thing in its tag. 

• Arrange the tags in the following order: content item, leader and then page number 
as children tags under the <Link> tag. This sequence will ensure the content is in the 
proper reading order. 

11. Ensure that the content item, leader and page number are above and a sibling to the 
Link-OBJR tag. The final structure of the TOCI item should be <TOC>, <TOCI> nested one 
level, <Reference> nested under TOCI, <Link> nested under <Reference>, and the 
content item, leader, page number, and Link-OBJR nested under the Link tag. 

 
12. Repeat the steps above to structure the other TOCIs. 
13. Verify that all the <TOCI> tags are at the same level (siblings) in the tag structure. 

 



 
 

 
 

To properly structure a non-linked table of contents <Reference>, <Link> and Link-OBJR 
tags need to be omitted from the tag structure. The structure needs to be <TOC>, 
nested <TOCI> and beneath the <TOCI> nest the contents item as <TOCI_Title>, leader 
(i.e "...") as an artifact, and page number as <TOCI_Page> as individual tags. 

 
 



 
 

PDF Resources 
• FEMA Creating Accessible PDF Documents 

o https://intranet.fema.net/help/section508/Pages/Creating-Accessible-PDF-
Documents.aspx 

• Emergency Management Institute  
o https://training.fema.gov/devres/508.aspx 

• Accessible Electronic Community of Practice YouTube Channel- Currently only MS 
Word Documents 

o https://www.youtube.com/channel/UC_rbJmvIT7j4OEQxF8UpBXA 
• Adobe Accessibility Resource Center 

o www.adobe.com/accessibility 
• Adobe Accessibility Blog 

o Blogs.adobe.com/accessibility/ 
• WebAIM PDF Accessibility Page 

o www.webaim.org/techniques/acrobat 
• Ohio State University Web Accessibility Center’s Accessibility and PDF 

o www.wac.ohio-state.edu/pdf/ 
• Lynda.com 

o http://www.lynda.com/Acrobat-tutorials/Creating-Accessible-PDFs-
2014/147579-2.html 

• Cal State 
o http://www.calstate.edu/accesibility/tutorials/pdf.shtml 

• Google. “PDF Accessibility Tutorials” 

 

For more information on Section 508 compliance, please visit the FEMA Section 508 Accessibility Resource Center. 
For assistance with Section 508 matters, please email the FEMA-Accessibility Help Desk. 
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